
 

.01    How do I avoid downloading files I can't use?

There are over 40,000 files in the Macintosh Forums on America Online. There are tens of 
thousands more in the other forums. If you're not careful, you'll spend hours downloading files 
that are worthless to you.

Check needs    Some files may require certain hardware or software you don't have. If you 
have a black and white computer, check to see if the software you're downloading requires color. 
Some files in the games library are saved games that require a commercial game to use.

Check System 7 compatibility  Some older software isn't compatible with System 7. 
Check the System 7: line. Likewise, some software requires System 7, and won't work with 
System 6. Some older sound files are in System 6 format, and won't work with System 7.

Check date    If the software is really old, it won't have information about System 7 
compatibility. If you're using System 7, beware of applications older than 1991. The uploading 
date is irrelevant – the file may have been uploaded years after it was created. After downloading
and decompressing the file, click its icon, choose Get Info from the File menu, and check the 
creation date. If the file is a document, such as a text file or a graphic file, the age doesn't matter.

Beware extensions and control panels (inits and cdevs)    Extensions and control 
panels can be great fun, but they can also gobble up RAM and cause crashes and freezes. Be 
selective about which ones you use, particularly if you use your computer for important business.
If you're using System 7.0, beware of any extensions older than 1992. If you're using System 7.1,
beware of any extensions older than 1993. Older extensions may work, but you should test them 
carefully.

Watch out for IBM software    The Macintosh forums have only Mac software, but other 
forums have software for Macs and IBM-compatibles. You can open text files and graphics files 
(GIFs, JPEGs, etc.) on the Mac, even if the files were created on an IBM. IBM applications 
won't run on a Macintosh unless you have the payware SoftPC program, an Orange Micro 
expansion card, a Quadra 610, DOS Compatible, or a PowerMac running SoftWindows. You can 
spot DOS applications because they end in "exe" or ".com" after they're decompressed.



7.02    What do "freeware", "payware'', etc. mean?

These terms refer to the software's legal status and distribution method. Here's a summary of the 
terms you're likely to see:

Public domain  The author of this software hasn't copyrighted it. He or she releases all rights 
to the software, which other may with no restrictions. Most of the software on AOL is 
copyrighted, which means it's not public domain. Some of the material that isn't copyrighted is 
actually violating someone's copyright. Paramount Pictures recently sued AOL, Inc. because of 
the illegal Star Trek sound clips on AOL.

Freeware    The author of this software has copyrighted the software and retains his intellectual 
property rights. However, the software may be copied, distributed, and used without payment to 
the author. There are usually restrictions on commercial distribution. Modified copies of the 
software may not be distributed.

Shareware    Shareware is similar to freeware in many respects. Users are expected to pay the 
author if they continue to use the software after a trial period. The length of the trial period and 
the exact terms are usually specified in the software or accompanying documentation. AOL does 
not charge the shareware fees to your account. Downloading the software doesn't obligate you to 
pay for it. Continuing to use the software after the trial period does.

Shareware is based on the honor system. To my knowledge, there's no legal precedent to show 
that shareware payments must be paid. You pay because you want to. If you use a shareware 
program, please pay the author. You'll reward the author's work and encourage him or her to 
write updates and new software. Without shareware, we'd all spend more money and be less rich.

Some people feel that the money they send in doesn't make a difference. That's not true at all. 
There are numerous stories of authors writing popular shareware and never receiving a dime. 
You could very well be the first person to pay for the program. A shareware payment is more 
than money. It's a compliment and an act of kindness.

Postcardware    Postcardware is like shareware in most respects, but in lieu of cash, the author
asks you to send him or her a postcard of your home town. Other variations are emailware, 
CDware, beerware, etc.

Payware    You have to buy payware before you can use it. Microsoft Word and ClarisWorks 
are examples. Payware cannot legally be uploaded to or downloaded from America Online or 
any other online service.

Demoware    This is a demonstration version of a payware program. Some demos are just self-
running "movies" of the product, and are less than helpful. Other demos are just limited versions 
of the real thing. For instance, a demo paint program might allow you to create and edit a 
document, but would not allow you to save your work. Some demos are fully functional, but stop
working after a certain date.



Apple software    Apple Computer, Inc. owns this software It is not freeware or shareware. It 
may only be distributed through authorized outlets, such as authorized Apple dealers, user 
groups, and online services that have made special arrangements with Apple. Most Apple-owned 
software on America Online is in the Macintosh Operating System Forum (keyword "mos").

Apple must approve any Apple-owned software before it can be released on America Online. 
AOL would like to provide the Speech Manager and the StyleWriter II driver for downloading, 
but Apple hasn't given AOL permission to do so. Some Apple software – such as System 7.1, At 
Ease, and Macintosh PC Exchange – is payware, and can't be downloaded from anywhere.

                                BBS sysops should be aware that it is illegal to 
                                have Apple Computer's software on their BBS
                                without a license from Apple. When I first got 
                                my modem, I uploaded Apple software to several 
                                BBSes. I didn't know any better, and neither did
                                the sysops. It may happen all the time, but it's still illegal.

7.03    Are the files on AOL infected with viruses?

Yes! Every single one of them! They'll infect your computer! Your hard drive will melt! Your 
screen will explode! When your Macintosh barfs smoke out the floppy drive, you'll breath the 
smoke and you'll get the virus! Then your dog will get the virus! Pretty soon every living thing in
your state will be dead! All because you wanted to play Tetris! You pig!

Ha ha! Just kidding! Let's look at the preceding untruths in detail. The files on AOL are not 
infected with viruses. No virus can damage computer hardware; viruses can only damage 
information. And no computer virus can infect a human or any other living thing. But if you 
didn't know any better, you might be afraid that all of these things could happen. If you're afraid 
of viruses, then the people who write the viruses have gotten to you just as surely as if their 
viruses had infected your computer.

Knowledge is the best weapon against fear. To learn more about viruses, download Disinfectant, 
launch it, and choose Disinfectant Help from the Apple menu. The help section will teach you 
everything you need to know about viruses. Disinfectant is a powerful virus fighting tool that can
detect and eliminate computer viruses. The instructions for downloading Disinfectant are in the 
software section.

There's a myth that BBSs and online services are prime vectors for viruses. This simply isn't true.
Most computer viruses enter their hosts through the floppy drive, not through the modem port. If 
you want to protect yourself against viruses, use Disinfectant to check the floppy disks you insert
in your computer. On America Online, the forum staff and the sysops in the company support 
forums check all uploads for viruses.

To go to the Virus Information Center on AOL, use keyword "virus". There you'll find a folder 
for reporting suspected viruses.



                           There are less than two dozen Macintosh viruses. 
                                There are around 3,000 IBM PC viruses!
                                Remember that the next time someone tells you 
                                there's more software for the PC!

7.04    How do I find files for downloading?

Instructions
1.    Choose Keywords from the Go To menu.
2.    Type "file search" (without the quotes). Click the OK button
3.    In the file search dialog box, type the name of the file you want.
4.    Click the List Matching Files button.

Often, you won't know the exact name of the file you want. Maybe you're looking for a calendar 
program. Try searching for the word "calendar". You'll find a slew of calendar programs, as well 
as reviews of calendar programs, demos of calendar programs, and message board archives that 
discussing calendar programs.

Here are some tips for using file search:
•Don't include a version number in the file search. You may be looking for an old version that is 
no longer on AOL.
•Spell the name correctly. You have to be a gud spelr when you're dealing with computers. If 
you're not sure of the name, try several spellings, or shorten the name to the part that you're sure 
of.
•Be careful with spaces. If you search for "jpegview", you'll find JPEGview. You won't find it if 
you search for "jpeg view".
•Start by making the search as broad as possible. Don't specify a date, and don't specify a 
specific area, such as utilities or communications. If the search produces too many files, then you
can narrow the search criteria.
•File search can't find files in company support areas. You'll have to go to the company support 
area to find the file and download it.
•File search can't find files in the User Group Forum. Use keyword "ugf" to browse the UGF 
libraries.
•If Files search can't find the file, it may not be available on AOL.

If you just want to browse the file libraries, you can do that, too. Use keyword "software". You'll 
see the file libraries for all the public forums, including the User Group Forum, but not the 
company support areas.

7.05    How do I find Apple-owned files for downloading?

You can use file search, as outlined in the previous section. If you want to browse for software 
released by Apple Computer, Inc., look in the Macintosh Operating Systems Forum (keyword 
"mos). Most Apple-owned software on AOL goes to that forum.



You won't find all Apple software in MOS, of course. Some of the software – such as System 
7.1, At Ease, and HyperCard 2.1 – is payware and can't be downloaded from online services. 
Some Apple software – such as the Speech Manager – can be downloaded only from AppleLink 
and ftp.apple.com, two services owned by Apple. AOL can't release Apple software until Apple 
gives its permission.

                                MacInTalk 1.5.1 is available on AOL, but it's 
                                not in MOS, and you can't find it with file search. 
                           It's in the Baseline company support area. Use 
                                keyword "baseline", doubleclick More..., and
                                doubleclick Software Library. MacInTalk is 
                                several screens down, so you'll have to use the 
                                More... button several times.

7.06    How do I cancel files I don't want to receive?

When the file begins downloading, you can temporarily stop it by clicking the Cancel button. 
(With AOL 2.1, the button is labeled "Finish Later".) When you sign off, you'll be told you have 
information to be sent and/or received.

To stop these messages, delete the file from the Download Manager. While offline or online, 
choose Download Manager from the File menu. In the Download Manager window, click the file
name, then click the trash can icon labeled "Delete List Item".

7.07    How do I upload files to the file libraries?

Instructions
1.    Use the latest version of Disinfectant or another anti-virus utility to check the files for 
viruses.
2.    Compress the file or folder with StuffIt Lite or StuffIt Deluxe 3.0. If you use anything other 
than StuffIt, make the file self-extracting.
3.    Type a description of the file.
4.    Sign on to AOL and use keyword "file search".
5.    Click the button labeled "Submit Files". Select a file library for your file.
6.    Fill out the questionnaire and paste in the description you typed earlier.
7.    Click the Send button. You'll be prompted to locate the file on your hard drive.

The AOL staff will check the file for viruses and make sure the file is allowed on AOL. After the 
staff approves the file, the billing department will reimburse the time spent uploading the file. 
You are not reimbursed for time spent typing the file description. For that reason, you should 
type the information ahead of time.

7.08    How do I post GIFs of myself to AOL?

You can send a photo of yourself to the Gallery in Arizona. The Gallery will scan your photo and
post it to the Gallery section of America Online at no cost. For more information and the address 



of the Gallery, use keyword "gallery" and read the file named "Get Framed".

If you have your own scanner, you can make a GIF of yourself and upload it to the Gallery. 
Again, use keyword "gallery" and the read the file named "Get Framed".

The Gallery on AOL has three categories of GIFs. The Portrait Galleries are for AOL members. 
Family Portrait is for members' family and pets. Rogue's Gallery is for staff members.

7.09    Can I preview GIFs as they're being downloaded?

Absolutely! All you need is a shareware program called GIFWatcher. GIFWatcher 2.2.0 works 
with AOL and virtually any other telecommunications program.

GIFWatcher Instructions
1.    Launch GIFWatcher and choose Open GIF from the GIFWatcher menu.
2.    Navigate to the folder where you want to save the GIFs. This would normally be the Online 
Downloads folder.
3.    Click the button labeled "Auto-Open From Here". GIFWatcher will now watch the folder 
you selected. Do NOT quit GIFWatcher or close its window.
4.    Switch to AOL, and begin downloading one or more GIFs. Be sure you save the GIFs into 
the folder you told GIFWatcher to watch.
5.    Switch to GIFWatcher. After a minute or so, the GIF will begin to appear. Select Best Color 
from the GIFWatcher menu to produce the best image. You'll have to repeat all five steps each 
time you use GIFWatcher.

7.10    How do I send files to my friends on AOL?

AOL makes sending files to other AOL members incredibly easy. Just write a mail message to 
your friend, and attach a file to the message.

Instructions
1.    Choose Compose Mail from the Mail menu.
2.    Fill in the To: and Subject: fields. Then write any message you like.
3.    Click the button labeled "Attach File".
4.    AOL 2.0: AOL will prompt you for the file you want to send. Navigate to the file, click on it, 
then click the Select button. You should compress the file with StuffIt Lite before attaching it.
4.    AOL 2.1: add all the files you want to send into the right hand window. Check the Compress 
Files box to automatically stuff the files as they're being uploaded. Click the Attach button.
5.    Click the Send Now icon. If you are not signed on to AOL, click the Send Later icon and use 
a FlashSession to send the message and attached file.

When your friend reads the mail message, he or she can download the file by clicking the 
Download Now or Download Later buttons at the bottom of the message. 

If your friend is using a non-Macintosh computer, compress the files with ZipIt, described in the 
software section of the FAQ. Keep in mind the rules for DOS file names. The name can be a 



maximum of eight letters with a three letter extension, as in "filename.txt". File names can 
contain letters and numbers only. No spaces are allowed, and file names must begin with a letter, 
not a number.

                                File attachments can only be used to send files 
                          to AOL members. If you try to send a message
                                through the Internet with an attached file, 
                                you'll receive the message "You cannot send fax,
                                Internet, or U.S. mail with an attached file."

7.11 How do I send files to my friends on other services?

This is much trickier than sending mail with file attachments to AOL members, because the mail 
has to travel over the Internet. Normal file attachments won't work. 

There's a standard technique for sending Macintosh files through the Internet via email. It's not 
quick, and it's not elegant, but it works. The technique involves binhexing a file.

All about BinHex and Uuencode

Problem  Most of the files you'll want to send are binary files: they use all eight bits of a byte. 
Most Internet mail systems only understand plain text (ASCII), which only uses seven bits. If 
you were to send a binary file through such a    mail system, the eighth bit of every byte would be
lost, turning the file into gibberish.

Solution 1: BinHex    BinHex solves both problems. It can convert binary files into text files. 
It also understands the Mac's two-fork file format (data fork and resource fork). 

Solution 2: Uuencode    UNIX users have used uuencode for years to convert binaries into 
text files. Uuencode is a better choice than BinHex if your friend is using a computer other than a
Macintosh.

A number of programs can convert files into the binhex format. One is called BinHex 4.0. There 
is also a BinHex 5.0. DO NOT use BinHex 5.0 to convert files to email. It is not a newer version 
of BinHex. Rather, it is used to convert the Mac's two-fork file format into a *binary* file that 
can't be damaged by non-Macintosh systems.

Compact Pro and StuffIt Lite can also convert files into the binhex format. In fact, you may want
to use them instead of BinHex 4.0, which reportedly has some bugs. StuffIt Lite and StuffIt 
Deluxe can also uuencode and uudecode files.

BinHex Instructions
1.    Compress the file using StuffIt Lite, ZipIt, etc.
2.    BinHex the file using StuffIt Lite, Compact Pro, BinHex 4.0, etc.
3.    Open the binhexed file in you word processor. (Launch your word processor, choose Open 
from the file menu, and open the file.)



4.    Launch the AOL software.
5.    Choose Compose Mail from the Mail menu.
6.    Fill out the Subject: and To: fields. Give the message a useful name, such as "Nude GIF of 
Steve Case, part 1".
7.    Return to your word processor. Using your mouse, select the first block of text and copy it 
using the Copy command in the Edit menu. The block must be smaller than 24 kilobytes (24576 
characters), because that's the maximum size of an AOL mail message You'll have to figure out 
on your own how much text 24K is. If you try to paste more than 24K into a mail message, you'll
get an error message saying "Paste would exceed field capacity. Be sure to copy the first line, 
which reads "(This file must be converted with BinHex 4.0)".
8.    Switch to the AOL software. Place the cursor in the body of the message and choose Paste 
from the Edit menu. If you were able to copy and paste the entire file into one message, you're 
done. Just click the Send Later icon, sign onto AOL, and send the message.
9.    If the binhexed file wouldn't fit into one mail message, click the Send Later icon. Then repeat
steps 5 - 9. When all of the text has been pasted into mail messages, sign onto AOL and send the 
messages via a FlashSession.

Your friend will have to copy the mail messages – in order – and paste them into a single word 
processing file. Then your friend will save the file as a text file, close the file, and de-binhex the 
file with StuffIt, Compact Pro, etc. 

The uuencoding and uudecoding process is essentially the same.

Like I said, it's not quick and it's not elegant, but it works. Sending binhexed files is not for the 
faint of heart. It's also pretty troublesome for large files, due to AOL's 24K limit on mail 
messages. It really does work if you're patient.

7.12    Can I download Mac files to a PC/PC files to a Mac?

Absolutely. The only caveat concerns downloading Mac files to a PC. AOL adds information to 
the files so that they can be used on a Mac. PCs don't understand this information and get 
confused. To get rid of this extra information, use AOMAC2PC.EXE to strip out the Mac 
information. You can find the program by doing a file search for "aol convert". 

To find PC files while using the Mac software, use keyword "pcsoftware".

7.13    How do I resume interrupted downloads?

First, don't do anything with the partially-downloaded file. Don't move it and don't rename it. 
While online or offline, choose Download Manager from the File menu. You should see the 
name of the file you were downloading. You will also see the %Complete, which tells you how 
much of the file has been downloaded. To complete the download, click the icon labeled "Start 
Download". The AOL software will sign on and complete the download. 

7.14    Why do my downloads get interrupted?



Call waiting    Call waiting should be turned off when calling America Online or any other 
online service. See chapter 5 for details.

Screen savers    If your downloads get interrupted after ten minutes, and your screensaver is 
set to go off after ten minutes, there's your answer! If you have After Dark, open the AD control 
panel, click When, and turn on the System IQ activity monitor. With System IQ on, After Dark 
won't go to sleep during the download. Otherwise, just turn off your screensaver during 
downloads. If you're worried about screen burn-in during downloads, turn the monitor off or turn
the brightness and contrast all the way down.

Other idletime programs    Try turning off other extensions that begin to work during the 
computer's idle time. Programs that perform idletime compression, defragmentation, virus 
checking and the like are the usual suspects. See chapter 3 for help with finding extension 
problems.

CP TrashBack    CP TrashBack is part of the MacTools package from Central Point. Early 
versions of TrashBack reportedly caused problems when downloading via the AOL Download 
Manager. TrashBack 3.0b fixes the problem, and is available in the Central Point company 
support area (keyword "central point"). The new version is in CP Backup format, so you'll need 
to open it with CP Backup, part of the MacTools package.


